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Lookeen – Your Complete Outlook and Desktop Search 

 
Thank you for installing Lookeen. Lookeen enables you to search your Outlook data, as well as your file 
system. This includes emails, conversations, contacts and much more. 

Lookeen helps you organize your daily work flow. You receive and write countless emails every day, which 
can quickly add up to a lot of time wasted sorting your Inbox or searching for important information in your 
archives. 

 Searches PST archives, MS Exchange Server, local and network files 

 Searches in e-mails, attachments, appointments, tasks, notes, contacts, and journals 

 Complete desktop search, even when Outlook is closed or not installed 

 Zeitersparnis bei der Organisation und beim Ablegen von Outlook Elementen 

 Saves time when you organize your files or Outlook elements 



 
 

NEW in Version 10... 

 
Lookeen is now a complete desktop search solution that can be independently operated without Outlook. 
By request Lookeen can also be installed as an integrated Outlook Plugin. 

Documents can be edited and saved in the Lookeen preview window. 

New wildcard functionality and filters to quickly reach better results. 

Search-As-You-Type: Lookeen starts searching, while the search term is being typed. 

Improved preview: documents like .pdf, .docx and .xlsx are displayed like in the corresponding application. 

  



 
 

Installation 

 
After accepting the license agreement, you have the option to select the destination folder for the 
installation: 
 

 
 
If you want something other than the default location for the installation, you can enter its path directly or 
use the “Browse” button to navigate. 
 
In the next window you can specify the folder in the start menu in which to add the Lookeen program 
shortcut: 
 



 
 

 
 
You can then choose whether Lookeen should make a shortcut on the desktop, if Lookeen starts 
automatically each time Windows starts, and whether Lookeen should be installed as a pure Outlook 
plugin. If installed as a pure plugin, Lookeen can’t operate independently, but is started and stopped with 
Outlook. The functionality of Lookeen is not affected; even as a pure Outlook plugin, Lookeen offers full 
desktop search capability. 
 

 
  



 
 

The Main Menu 

 
In the main menu, you can add actions for selected items, customize the layout of the Lookeen window, or 
start the indexing process manually: 
 

 
 

File 

In this menu you can completely stop Lookeen by selecting "Exit". 
 

Edit 

Here you have the most popular Lookeen functions at hand: "Start Search", "See conversation with 
selected person", "Topic" and "Summarize". 
You can also use popular Outlook features directly from Lookeen, such as: reply, categorize, delete, etc. 
 

View 

This menu allows you to customize the way Lookeen search results are displayed. 
 

Preview 

With Lookeen you can display a preview of your search results, and enjoy the familiar look and feel of 
Outlook. You have the choice of displaying the preview to the right or below your search results. 
 
Simply go to “View“ -> “Preview“ 
 

 
 

Image Preview 

With Lookeen you can also display image files such as JPG, PNG, BMP (etc.). Use this menu to select 
how the images are displayed. You have the choice between "Zoom" (stretched to the size of the preview 
window), “Center” (centered in original size in the preview window), or "Off". 
 



 
 
Preview on Motion 

With "Preview on Motion" you can choose whether the preview pops up when you hover the cursor over 
the item, or only when you click on it. 
 

Customize Columns 

You can select the columns that appear in the results page. By clicking "Customize Columns" a window 
opens in which you can make your choice: 
 

 
 
 

History 

Lookeen remembers your previous searches. Here, the last 21 searches will be saved regardless of 
search success. You can easily re-select previous searches by clicking on "History". 
 



 
 

 
 
You can select "Clear History" to delete the search history and get a better overview. You can disable the 
history function in options: 

 
 

Favorites 

Search favorites were developed for instances where the database that is searched changes frequently, 
but the queries remain the same. You can save and organize your most frequently used search criteria. 
 
Enter your search term and then go to "Favorites" -> "Add to Favorites ..." 
 

 
 
 



 
 
Your search parameters are set in the following field. Now you can assign a name under which the query 
should be saved. 
 

 
 
Click the "Favorites" menu to see and select saved searches. 

 

 
 
In the "Organize Favorites ..." menu, you can edit, rename, delete or change the order in which favorites 
appear in your list. 
 



 
 

 
 
 

Index 

In order to search your data, Lookeen creates an index of your email messages, contacts, calendar 
entries, and your file system. Lookeen manages this index efficiently and unobtrusively in the background. 
During the indexing stage it uses a minimal amount of the computing capacity, so that you can continue to 
work unhindered while the index is created. 
 

 
 
In the "Index" menu, you can start, stop or pause the indexing process. 
You can click the "Start" button to start the indexing process manually. Generally, you don’t need to do this 
because the default settings will perform the indexing automatically. 
 
When you click "Pause", indexing will be stopped for an hour. After one hour, the indexing will 
automatically resume or you can simply click "Next" to continue indexing. 
 
If you don’t want Lookeen to index now, you can click the "Stop" button. It may take a few seconds for the 
index operation to stop. The indexing process will stop and your index will remain in a usable state. When 



 
 
you're ready to resume indexing, you can click the "Start" button or simply wait until the scheduled 
automatic indexing operation starts by itself. If you cancel or stop indexing, you do not have to start all over 
again the next time - Lookeen remembers the point where you left off and jumps to that position. You can 
also close Outlook during an indexing process – Items which were already indexed won’t be lost! 
 
You also have the ability to completely rebuild the index, i.e. to delete, and then start the full indexing from 
the beginning. 
 

Options 

Open the options window by clicking on "Options". The options are described in detail in a separate 
section. 
 

? (Help) 

This menu allows you to find help options, which are described in a separate section. 
  



 
 

The Search Bar 
 
Enter your search term in the search bar. If the "Search-As-You-Type" option in Options -> Search is 
enabled, Lookeen will start searching as you type. Otherwise, enter the search term and press Enter or 
click the magnifying glass to start the search. 
 

 
 
 
Lookeen remembers your search queries (see also Main Menu -> History). Click on the arrow icon in the 
box to open the list of search terms you have already entered. On the left side of the search bar you will 
find the arrow buttons that let you move back and forth through the list. Next to it is the delete button X, 
which lets you reset the search, i.e. you delete the entered search term and all other search criteria. 
  



 
 

The Results Area 

 
In the results area you’ll see all items that match your search criteria. The default number of results 
displayed is limited to 5000. You can increase the maximum number in Options -> Search. 
 

 
 
 

Result Type Selection 

At the top of the results area there are tabs for the various category elements. 
 

 
 
The results for each category are displayed by clicking on a tab. You can return to the complete results list 
by clicking on the "All" tab. 
 

Select Columns 

To the right of the category tabs there are three buttons. Click the left one to select the columns to be 
displayed (see Main Menu -> View -> Customize Columns) 
 



 
 
Change preview details 

With the middle of the three buttons, you can select how many rows of the content of an element are 
displayed in the results area. By clicking this button, you can switch between none, 1, 2 or 3 lines. 
 

Advanced search fields – Hide or Unhide 

You can turn the advanced search fields on and off with the button on the right. 
 

Advanced search fields 

With the advanced search fields,  you can refine your search in many ways. 
 

 
 
Above the “Type” column is a drop down menu for the type of result to which you’d like to restrict the 
search. You have a choice between “Everything”, ”Mails”, “Attachments”, “Contacts”, “Notes”, 
“Appointments” and “Files”'. 
 

 
 
Above the “Date” results column is a drop down menu for the date range to which the search should be 
limited. You have a choice between “Everytime”, “Today”, “This week”, “This month”, “This year”, and 
“Custom Interval”. Your search word is searched only within the time limits specified by you. If you select 
“Custom Interval”, the following window will open and you can enter your desired period. 
 

 
 
Above the “Archive”’ result column is a drop down menu for the archive in which the search should be 
performed. You can search all of the archives that you have added to your index. Multiple selections are 
also possible. 



 
 

 
 
Lookeen offers even more search fields that can help you narrow down your search. These are: 
 

 Subject, To (= recipient), From (= sender), Category: for the corresponding email properties 

 Folder: Use to limit the search to a single folder. It can be an Outlook folder or a folder from the file 

system. 

 Path: Similar to folder, only that here you must specify the path you want to search. In contrast to 

searching a folder, subfolders will also be considered in this search. 

 Name, Company: For contacts 

 File, File Extension: For Email attachments and files stored locally or on the network  

 Location: For appointments and meetings 

Enter your search term in the respective search field and press Enter or click the magnifying glass to start 
the search. The search fields can also be combined, of course. 
 

The Context Menu 

 
Double-click on an item to open it. By right-clicking on an item, the context menu will open with options to 
refine and restrict your search queries, as well as edit the selected element. 
  



 
 

 
 

Conversation 

To get an overview of all correspondence between you and another person, select an email from the 
person and then select “Conversation” 
 

Conversation with 

If you want to get an overview of all correspondence between you and all persons who have been a part of 
an email thread (e.g. as the sender, CC, or BCC), please mark the e-mail and then select "Conversation 
with". 
 

Mails to and Mails from 

With the “Mails to” and "Mails from" selection, you can find all the e-mails "to" or "from" the participants of 
the selected e-mail. 
 

Topic 

To start a search for a specific subject, check the appropriate email in your search results and select 
"Topic". 
 

Timespan Between 

When you select two different emails in the Lookeen search result window, you can click on "Timespan 
Between" - to get an overview of the correspondence between the date of the first and second selected 
emails. 
 



 
 
Extract email addresses 

This function lists all email addresses contained in an email in an editor window. Both the sender and 
receivers are detected, as well as addresses in the content of the email. 
 

Repeat search including only.... 

You can narrow down your search results by clicking "Repeat search including only ...". 
This allows your search query to be limited by only looking at emails with the same sender, subject, store, 
in the same folder, or those that are received on the same day, week or month. (The date refers to the 
selected email in your Lookeen search result window). 
 

 
 

Repeat search hiding... 

You can refine your search results in a similar way using the "repeat search without ..." button. As a result, 
only elements without the same sender, subject, store or folder will be included in the new search results. 
 

 
 

Summarize 

Click on "Summary" to create an email that summarizes the correspondence of all selected emails in list 
form. 
 
 

Move to folder, Copy items to folder 

Do you want to move or copy an email to another Outlook folder? Simply select the relevant email in the 
Lookeen search result window and click "Move to Folder" or “Copy items to Folder” in the context menu, 
then select the destination folder. 
  



 
 
Delete Item 

This allows you to delete the selected item. 
 

Categorize 

If the selected item is an email you can set a category here. 
 

Reply, Reply All, Forward 

These are the same as the usual actions that you perform with emails. 
 

Customize Columns 

This opens the “Select Columns” window where you can choose which columns are displayed in the 
results area. 
 

The Details Area 

 
When you select an item by clicking on it in the results list, it will be displayed in the details area. 
 



 
 

 
 

Topic 

If it is an email or an email attachment, you can display all further emails with the same or similar subject 
line using the "Topic" button. 
 

Conversation 

The "Conversation" button lists all correspondence involving the people included the selected email. 
 

Select preview mode 

Using the "Select preview mode" button on the far right hand side, you can determine how elements are 
displayed in the preview: either “Show preview of document”, “Original document (read-only)” or “Original 
document (Edit mode)”’. While the pure text preview offers the advantage of instantaneous preview, the 
original preview shows the document as it appears in the associated application after it has loaded. 
 



 
 
Edit documents 

New in Lookeen 10 is the ability to edit local documents directly in Lookeen preview. To do this, select 
“Original document (Edit mode)”. You can edit the document within the preview, then save the edited 
document by clicking on "Save". 
 

 
  



 
 
 

The Status Bar 
 
The status bar shows you how many results your search returned, how many items are currently found in 
the index, and possibly also the online status of a connected Lookeen server. During indexing, you can 
also see which folder is being indexed. 
 

 
 
By clicking on the number of items in the index at the right-side of the status bar, you’ll open the file 
lookeen_detailed_index_log.txt from the Lookeen user directory. This file includes detailed data on the 
index, such as start and end times of indexing and the number of indexed items in each folder. 
  



 
 

Options 
 
Here you can see the options window. Use this window to define how emails and files are indexed on your 
computer, how search queries are processed and how Lookeen is integrated into Windows. 
 

 
 

Index 

Here you can specify which folders should be indexed and searched by Lookeen. 
If you click the plus sign next to a folder, you can display the subdirectories and activate each one of them 
by checking the box, or disable them by un-checking the box. 



 
 

 
 
 

Tip: The first indexing may take some time to complete. This depends on type and size of your 
data. After your data has been initially indexed, the subsequent indexing operations go much more 
quickly. This short indexing process only adds all newly obtained, moved, deleted, or changed items 
(e.g. newly created tasks, appointments or new e-mails). 

 
 

Add Store 

Use the "Add Store" button to open a new window in which you can add your local directories, Outlook 
folder, external indices (Shared Index) or Lookeen Server to the list of archives to be indexed and 
searched by Lookeen. The new file or Outlook archives will be included in future indexing, the external 
index source(s) and/or the Lookeen Server(s) are immediately available. 



 
 

 
 

File System Archive 
Specify a path to a local data directory or click on the "Browse" button to navigate in a selection window. 
 

Microsoft Outlook Archive 
Select an existing Outlook folder or create a new one. 
 

Discover new Outlook Archives 
With this button you can have Lookeen manually search for newly added Outlook archives. In the case of 
a find, you will be asked if you want to add the archive(s) to the index. 
 

 
 

Tip: "Detect new Outlook archives when Outlook starts” 
With this option (tab "Outlook"), you can have Lookeen check on each Outlook start whether new 
Outlook archives have been created and haven’t been added to the index yet. 



 
 
 

Lookeen Shared Index 
Here you can specify the path to an external index source (Shared Index). More information about shared 
index sources can be found in a separate section. 
 

Lookeen Server 
Enter the address (URL) and other options for the use of a Lookeen server (see below). 
 

Remove 

You can delete existing directories by selecting them and clicking "Remove". 
 

Edit 

If you are using one or more Lookeen Servers, select the desired one in the list and click on the “Edit” 
button to configure it. 
 

 
 
In this window you can enter or change the URL of the Lookeen server. Additionally, you can change the 
timeout interval, after which a server request is canceled. The default time is 15 seconds. 
 
The "Use default credentials" option is enabled by default. This means that the user's login information is 
used for authorization on the Lookeen server. You can disable this option and specify login information of 
another user to use the Lookeen Server with these permissions. 
 
With the "Test Settings" button, you can check the availability of the Lookeen server. 
 
More information about the Lookeen Server can be found at: http://www.lookeen-server.com 
 



 
 
Indexing Schedule 

The indexing schedule allows you to specify how often and at what times Lookeen should perform an 
update or re-indexing of your data. 
 

 
 

Index items automatically, every and Clear index automatically, every  

You can specify a time interval in which Lookeen should regularly execute an indexing of your data. 
It is advisable to periodically delete your index and completely rebuild it to safely update old, moved, or 
deleted entries in your index. You can also enable this option here. You can also choose whether you will 
be asked for confirmation before a rebuild starts. 
 

Don’t perform index from and ‘Start indexing only during 

Here you can select the time periods in which re-indexing of new, moved, deleted, and modified elements 
will not take place. If you want to set, for example, that Lookeen will not perform indexing between 8:00 to 
18:00, you can check the check box "Don’t perform index from" and then set the appropriate times. 

Note: The "Don‘t index during the period from" prevents your index from starting during this time. 
However, an index process that has already been started before that time will continue until 
completed. 



 
 
Minimum time between indexing and Minimum time before first indexing starts 

To reduce the load on system resources, you can specify a minimum time that should pass between two 
indexing processes. Also you can set the time to wait after starting Lookeen until the first indexing takes 
place. The minimum time for this is 90 seconds. 
 

Real-time indexing 

Thanks to the real-time indexing Lookeen finds all emails and other data in real time. The real-time 
indexing will provide the latest data to all Lookeen users - whether on Exchange servers, in public folders, 
Citrix, Terminal Server environments or on the network. You can also select how many items must be 
changed before indexing starts. 
 

Index Details 

Here you can specify, among other things, where your index file is saved and which file types should be 
indexed. 
 

  
 

Local index data path 

Here you can define where the Lookeen index is stored. In addition, you can also see how many items are 
currently in your index. By clicking "Delete Index", you can delete it completely. 



 
 
 

Index files with extensions 

You can also add additional file formats so that they can also be found. Just add additional file formats and 
see if they’ve been indexed! The file extensions that are supported and tested by us have already been 
added. If you want to index all kind of files (not recommended) you can simply specify that with a ‘*' 
wildcard. 
 

Regulate the speed of the indexing process 

Here you can specify how much computing capacity is available for indexing. If you set the indexing speed 
to "Fast" more computing capacity will be used by Lookeen than when you put it on "Slow". If you run 
resource-intensive applications that are slowed by the indexing, you should set the indexing speed to 
"Slow". 
If Lookeen indexing runs slower, it requires less computing capacity and other programs can use the spare 
capacity. 
 

Always optimize index 

Lookeen starts a defragmentation of the index data after indexing if this option is selected. This makes the 
indexing take a bit longer than running it without this option selected. 
Query results arrive even faster since this process compresses the size of the index folder. 
Click the “Optimize Index” button to start the optimization of the index immediately. Please note: This may 
take some time to complete. 
 

Maximum characters in preview 

If you use the Lookeen preview, you can set how many characters of each element are provided in 
preview. Since Lookeen indexes your file contents anyway, a larger number only minimally affects 
indexing speed, but it increases the amount of hard disk space needed for the index. 
 

Search 

In this sub-menu, you can set specific search parameters of your search. 
 



 
 

  

Enable global shortcut (Ctrl, Ctrl) to start Lookeen from Windows 

By pressing the Ctrl key twice, you can open the Lookeen search window. 
 

Enable shortcut (Ctrl-F) within search dialog 

This allows you to search using the key combination Ctrl-F. 
 

Use search history to store your search queries 

Lookeen remembers the search queries that you’ve made with Lookeen previously. 
 

Activate ‘Search-as-you-type‘ mode 

If this mode is enabled, Lookeen starts searching while the search term is being typed. Otherwise, enter 
the complete search phrase and then press Enter to start the search. 
 

Repeat search with * -wildcard, when no search result 

If there are no results for your search, Lookeen will automatically re-search for your keyword and append a 
wildcard to find all possible results. 
 



 
 
Repeat search with * -wildcard at begin of query when no search result  

As in the previous case, except that this time the wildcard will be inserted before the search term. 
 

Always use *-wildcard at begin of query 

When enabled, Lookeen will automatically add a wildcard before every search term. 
 

Your Email addresses and Aliases of yourself 

Here you may include your name, as defined in Outlook, and enter your email address. Lookeen highlights 
all emails of which you are the sender. 
 

Maximum results to return on each search 

This is the maximum number of items that can be displayed in the search results. Increase this number if 
you do not see the results you’re looking for in the first 5000 returns. 
 

Outlook 

With this tab you can set Outlook-specific settings. For example if you want to index attachments to emails 
or not. 
 



 
 

  
 

Index Outlook Categories 

Select this option to index Outlook categories. The indexing speed may drop under certain circumstances. 
 

Tip: Please note that categories are only searchable after re-indexing. In order to see the 
categories in the search window, you have to add the column "Categories" to your search results 
window, using ‘Customize Columns’ in view settings as detailed in an earlier section. 

 

Index Attachments 

Attachments are indexed by default. If you do not want to index attachments, uncheck the box. Although 
the indexing will be faster, you might not find what you are looking for. 
 

Skip junk folders and 'Deleted Items' folders 

If this option is enabled, these two Outlook folders will not be included in the index. 
 



 
 
Skip encrypted items 

PST files often have encrypted items. The security protocol of Outlook normally requires authentication to 
allow access to these elements. If you want to index encrypted elements you will be prompted during 
indexing to confirm file access. 
The default setting of Lookeen therefore is set to skip encrypted items. This ensures that indexing can be 
done without you being present. 
 

Open Outlook when needed 

Outlook needs to be open when Lookeen wants access to Outlook data for searches or indexing. You can 
specify how Lookeen opens Outlook when required: with confirmation, without confirmation or never. 
 

Detect new Outlook archives when Outlook starts 

By request, Lookeen can check at startup if new Outlook archives are available that are not yet included in 
the list of ready to index archives. 
 

Show confirmation dialog 

If the archive search option is enabled and new archives are encountered, this option lets you select 
whether you will be prompted for confirmation before the archives are added to the index or not. 
 

Add new archives to indexing by default 

If this option is selected, new archives that are found will automatically be added without confirmation.  
 

System 

Here you can specify, among other things, what language to use within Lookeen, or whether the Lookeen 
icon appears in the taskbar. 

 



 
 

    
 

Settings location 

Here you can see the path where Lookeen saves the settings. 
  

Do not index if one of these (slow) networks is active (network blacklist) 

With Corporate networks in particular, it is often the case that a particular network connection is very busy 
and / or slow. Lookeen has network settings for this reason. With this feature, you can create a blacklist. 
The indexing doesn’t start when networks included on the blacklist are active. 
 
With the "Choose Networks" button, you can display all the available networks. You can then add all 
networks and manually delete unwanted ones off the list, or enter the desired networks in the list manually. 
 

Confirmation dialog before indexing if a slow network is active 

Here you are warned again if the indexing starts and the blacklist is active. This allows you to check again 
if you want to index with the given settings. 
 



 
 
Language 

You can choose between German, English and Spanish. Lookeen uses the language of your operating 
system by default. 
 

Log File Detail Level 

You can choose between different levels of detail for the log file. By default, Lookeen uses "Full" detail 
level. You can also view or delete the log here. 
 

Check for updates 

Lookeen will automatically check to see if a new version of Lookeen is available when you start Outlook. 
 

Show icon in system tray 

This option adds the Lookeen icon to the taskbar. If you click the icon in the taskbar with the right mouse 
button, you can use the basic functions of Lookeen. See also the "Windows Integration" section. 
 

Show balloon popup information 

Lookeen will inform you with a popup notification when the indexing starts in the background and when it’s 
finished. 
 

Show general warnings 

Lookeen lets you know when warnings occur. 
 

Automatic cache cleanup to minimize memory usage 

On older systems or with special settings, it’s possible that your system's cache is not flushed properly. 
Please check this to save your memory space and to ensure that the cache is emptied regularly. 
 

Show warning when application is closed while indexing 

Lookeen will warn you if it’s indexing isn’t completed and you want to stop Lookeen. 
  



 
 

Windows Integration 
 
Lookeen offers a quick way to search by using the Lookeen icon in the system tray: 
 

 
 
By right-clicking on the icon to open the menu, you can enter your search terms directly into the textbox. 
Pressing the Enter key or clicking on “Search” opens the Lookeen window and the search is performed for 
the term you entered. By double clicking on the icon, the window opens without Lookeen search term. 
 
You also have the option to open the Options window directly or to close Lookeen. 
 
If you don’t want to use the Lookeen icon in the taskbar, you can disable it in Options\System.  



 
 

Outlook Integration 
 
Lookeen integrates itself in two ways into Outlook: with the Outlook ribbon and as a search bar. 
 

Lookeen in the Outlook Ribbon 

 

 
 
You can view the Lookeen tab by clicking on "Lookeen" in the Outlook ribbon. 
 
One click on the "Lookeen" logo opens the Lookeen window, if it is not already open. 
In the text box, you can enter your search term(s) and then start searching by pressing the Enter key. 
 
When an email is selected and you click on the "Topic" button, Lookeen will display all of the emails with 
the same subject of this email. 
 
A click on "Conversation" lists all the emails that were sent between you and the sender or receiver of the 
selected email. 
 
A click on "Options" opens the Lookeen options window. 
 

The Lookeen search bar 

The Lookeen search bar is normally displayed above the Inbox and can be found in the same place in all 
other folders of the Outlook mailbox. 
 

 
 
Except for the button to open the options window, the Lookeen search bar contains the same functionality 
as the Lookeen tab in the Ribbon. 
 
To open the Lookeen window, click on "Lookeen". 
 
The "Conversation" and "Topic" buttons correspond to the Lookeen tab buttons. 
  



 
 

Search words & Query Syntax  

 

Basic query syntax 

 

Dog Documents mentioning dog  

Dog Cat Documents mentioning dog and cat 

Dog Photos - Cat Mentioning both dog and photos, but not cat 

"Dog Breed" Documents where the term “dog breed” is mentioned 

 
 

Advanced queries 

 

D?g* 
dogs, digger, dagger. The parameter ? stands for any single 
character, the parameter * stands for any number of characters. 

“Dog Breed“~10 dog and breed within 10 words of each other 

 
 

Additional search help 

 

subject:dog* dog, dogs, dogcatcher etc. in the subject line 

to:Martin (or from:, cc:, 
bcc:) 

To (including from, CC, BCC) Martin 

body:dog dog in the message body 

Store:Archive searches the search term only in the “Archive” store 

folder:Inbox the search term is only searched for in the “Inbox” folder 

date: [YYYYMMDD TO 
YYYYMMDD] 

the search term is only searched for within the specified time frame 



 
 

from:“Martin Welker” Searches only emails from this sender 

-from:“Martin Welker“ 
(or -folder:, -store:) 

Excludes this person/folder/archive from the search query. 

from:sales@lookeen.net Searches only for emails from sales@lookeen.net 

from:sales 
Searches only for emails from senders that contain “sales” e.g. 
sales@lookeen.net 

cat:Private searches the search term only in elements with category “Private” 

 
The following table contains all of the search help that you can add to a search term in the search box: 
 

cc:Name Searches for the specified name in the cc field 

bcc:Name Searches for the specified name in the bcc field 

subject:subject Searches for the specified term in the subject field 

date:[YYYYMMDD 
TO YYYYMMDD] 

Restricts the search to the specified period. date: [20150101 TO 
20150115] for example, searches for the period 01/01/2015 to 
15/01/2015 

from:Name Searches for the sender “name”  

atts:file name Searches for emails that have attachments with the specified file name. 

to:Name Searches for the recipients “name” 

fn:file name Searches for attachments or files with the specified file name 

folder:folder name Searches only in the given folder 

type:file type Searches for the specified data type: mail, attachment, contact, note, 
calendar, journal, file 

company:company Searches for the specified company name in contacts 

start:Date Searches the dates after the specified date for the beginning. The date 
must be specified in the format YYYYMMDD, for example 20150114 for 
14/01/2015 

name:Name Searches for the specified name in contacts 

due:Date Searches in tasks by the specified due date. The date must be 
specified in the format YYYYMMDD, for example 20150114 for 
14/01/2015 

received:Date Searches for emails that have been received on the specified date. The 
date must be specified in the format YYYYMMDD, for example 
20150114 for 14/01/2015 

sent:Date Searches for emails that have been sent on the specified date. The 
date must be specified in the format YYYYMMDD, for example 
20150114 for 14/01/2015 

cd:Date Searches for all kinds of data (files, emails, contacts, etc.) that were 
created on the specified date. The date must be specified in the format 
YYYYMMDD, for example 20150114 for 14/01/2015 

md:Date Searches for all kinds of data (files, emails, contacts, etc.) that have 
been changed on the date indicated. The date must be specified in the 
format YYYYMMDD, for example 20150114 for 14/01/2015 
 

idat:Date Searches for all kinds of data (files, emails, contacts, etc.) that have 



 
 

been indexed on the specified date. The date must be specified in the 
format YYYYMMDD, for example 20150114 for 14/01/2015 

cat:Category Searches for e-mails that match the specified category. Note: The 
indexing of categories needs to be enabled in the options menu, and 
indexing has already been done with this option enabled. 

fname:First Name Searches the contacts for the specified first name 

phone:Number Searches the contacts for the specified telephone number 

location:Location Searches the calendar for the specified location 

body:Text Searches emails or files that contain the specified text as content 

att: file extension Searches for messages with attachments of the specified type. Shown 
are both the email and its attachments. 

ext: file extension Searches for the specified type files and attachments. Related emails 
with attachments are not displayed, but can be opened ("Open 
underlying item") via the context menu. 

 
  



 
 

Help Options 

 
You can click on "?" in the Lookeen menu bar for the following functions: 

 
Lookeen User Guide 

If you click on "Lookeen User Guide", it will open in your browser. 
  

Online Support 

Contact us with our online support form at www.lookeen.net 
 

Send Report... 

If you have any suggestions for us, or if problems in the use of Lookeen occur, please use this menu to 
contact us. This function contains some information about your installed Lookeen (such as the version 
number, your log files and your Lookeen configuration file, etc.) and will create an email for our Lookeen 
Support Team. You can change or delete the contents of this email in whole or in part before it is sent from 
your computer. 
 

Check for Updates 

If you click this button, Lookeen will check if a new version is available - but you need to be online to do so. 
If Lookeen has a problem with your proxy settings, your firewall, your router or some other problems, the 
update search does not work. However, this is not a problem: in this case you will be sent to a website, 
where you will receive instructions. 
 

Buy and register 

When you buy Lookeen you will receive license data from us or one of our authorized agents, which will 
allow you to use the full version of Lookeen. Add the Registered User license from the data sent in the field 
"Registered User/Organization" and the license key into the field "Registration Key". Afterwards, please 
click on "Register". 

http://www.lookeen.net/support/


 
 

 
 

Tell a friend 

Do you like this program so much that you want to recommend it to others? This menu makes it easy for 
you to do so. 
 

About Lookeen 

This menu displays the program name, the EULA (End User License Agreement), some registered 
copyrights for this version and the current version number.  



 
 

External Index Sources (Shared Index) 

 

Overview 

Normally each user has their own personal index for their data. However, it can be very useful, not only to 
have a personal index, but also to search in several Lookeen indexes. Suppose that in a corporate 
network, there are many public documents or large public folders are stored on an Exchange server that 
need to be used by many users. Normally, each user would have to bear the personal responsibility to 
indexing this data. This, however, relies upon each user to remember and take the time to index, which 
changes the way they work, while also increasing network traffic. 
 
With the "Shared Index" feature, a user creates a central index and makes this accessible to all users. This 
is simply done by passing-on the index path. Individual users can now simultaneously browse through 
personal and external indexes. 
 

 
 

Using the "Shared Index" function 

In the options under "Index" you have the option to "Add New Archive" and then by double clicking on 
"Lookeen Shared Index" you can integrate new index sources. Please note: The path to the index source 
is always the "Reading" directory of the index! 
 



 
 

 
 

Important Security Note: The Lookeen index will not have Active Directory access rights or other 
rights structures built in - when a user adds an external source index he has full access to search 
this data. This means: If the user who created the external index has more rights than the user who 
adds the index, this user may get access to data via the external index for which he has no 
authorization. Please take care of to whom you make the external index sources available and 
which location you select for the index path. 

 

Generate an external index source 

An external source index doesn’t differ in structure from a conventional personal index. 
 

Tip: If you want to use local or network folders, please make sure that you include these folders 
with their UNC path. Simply share the folder first for network access and add it via "Network". Any 
user who wants to search or open the data, must have access to this network resource. 

 

Searching with external index sources 

You can exclude external indexes from your search on request, for example, when you know that the 
desired data can be found in your local index. To remove indexes from a search, simply go to the ‘Index’ 
tab in Options and uncheck the box next to the index source. 
Note that a search of the external index will always take more time to complete than a search of the local 
index. If you only occasionally need data from external sources, it is advisable to keep it turned off. You 
can re-enable it for individual searches. 
 

Possible Application Scenarios 

- Access to all PST files, even if this is not integrated into your Outlook 
- In the corporate network: your public folder can be indexed centrally! 



 
 
- In the corporate network: centrally index your network documents! 
 

Browse PST files that are not included in the work profile 

You know when you need to access important data stored in a PST file that is not currently bound to your 
work profile? Lookeen helps you access it! 
 

How To: 
1. Create and open a new archiving profile in Outlook. This can be done in the Control Panel under 

the menu item ‘Email‘. 

2. Embed the desired PST files into the archiving profile. 

3. Set the index path (archive index). In Options under the “Index Details” tab, you can define and see 

where the index is created. 

4. Start the archive index of all PST files. 

5. Close the archiving profile and open your personal Outlook work profile. 

6. Add the archive index path to your work profile as an external index. 

7. Now all PST files can be searched in every search without being included in the work profile. 

Of course, more than one user can add this archive index, which saves time indexing overall. 
 

Tip: If you find an email within a PST archive that is currently not included in your work profile, you 
can include it by simply right-clicking on the found item and selecting “Open PST File” in the context 
menu. 

 
Tip: Interested in an automated, server-based index solution of your enterprise-wide data that won’t 
burden your network? Send an email to: sales@lookeen-server.com. 

  
 

mailto:sales@lookeen-server.com

